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Regulatory Compliance

The ADSP-CM408F EZ-KIT Lite is designed to be used solely in a labo-
ratory environment. The board is not intended for use as a consumer end
product or as a portion of a consumer end product. The board is an open
system design which does not include a shielded enclosure and therefore
may cause interference to other electrical devices in close proximity. This
board should not be used in or near any medical equipment or RF devices.

The ADSP-CM408F EZ-KIT Lite is in the process of being certified to
comply with the essential requirements of the European EMC directive

2004/108/EC and therefore carries the “CE” mark.

The EZ-KIT Lite evaluation system contains ESD (electrostatic discharge)

sensitive devices. Electrostatic charges readily accumulate on the human

body and equipment and can discharge without detection. Permanent dam- A
age may occur on devices subjected to high-energy discharges. Proper ESD

precautions are recommended to avoid performance degradation or loss of ‘ % \
functionality. Store unused EZ-KIT Lite boards in the protective shipping

package.







CONTENTS

PREFACE

Product OVEIrVIEW .oovueeiiiiiiiieiieiiiiiiieeee e e e e e X
Purpose of This Manual .........ccoccoiiiiiiniiiiiie xiv
Intended AUdIence ....ccevvviiiiiieeiiiiiiiee e xiv
Manual CONTENTS .eeeiiiiiiiiiiiiiiiiieee e e e XV
What's New in This Manual .......ccccccoiiiiiiiiiiiiiiiieeee e, XV
Technical SUPPOIT weooviiiiiiiiii e xvi
Supported Processors .......eeiivuiieiiiiiiiieeiiieeeeeiiee e xvi
Supported Tools ...ccceiiiiiiiiiiiiiiii xvii
Product Information .......cccceeeeeieeiiiiiiiiiieeee e xvii

Analog Devices Web Site .....ccccooiiiiiiiiiiiiiiii xvii

EngineerZone .......ccccoceiiiiiiiiiiiiiiiiiiiiiii xviii
Notation CONVENTIONS ..eeeeeieiiiiiiiiieeeeeeeeettiiiiiiae e e eeeeeeeaniiaeeeeeeas Xviii

USING ADSP-CM408F EZ-KIT LITE

Package CONTENTS ...cocuviriiiiiiiiiiiiiiiiiceieeee e 1-2
ADSP-CM408F EZ-Board ......covvveiiiiiieiiiiiie e 1-3
Default Configuration .......c.ccceeevieeiriiiiniiieiieeeiicceeec e 1-3
IAR Embedded WorkBench and Board Installation ...........cceeeeennn. 1-5

ADSP-CM408F EZ-KIT Lite Evaluation System Manual



Contents

IAR Embedded WorkBench Session Startup .......cccccoviiiiniiiinnnecnn. 1-6
SRAM Memory (U2) ..eeiiiiiiiiiiiiiiieeeeeeeiieeeeee e 1-8
SPI Flash ..eoiiiiiiiiiii e 1-8
Analog Interface .......ccccevviiiiiiiiiiiiiiiiiic e 1-8
UARTO Interface (RS-232) oooiiiiiiiiiieeeeeeeeeeeeeeee e 1-9
UART1 Interface (RS-485) .oivviiiuiieeiieieiiieiieeee e 1-10
CANO INTErface ..eeeevouviiieiiiiiieeeeiiiee e 1-11
CANT INTEIFACE tovvveiriiiiieeeeeeeiiieeee e e e ee e 1-11
USB OTG FS Interface ...cccovuveeeiiiiiiiiiiiiiiiieeeieeee e 1-12
Ethernet Interface ......ccceeviiiiiiiiiiiiiiiiiiieeee e 1-12
Debug Interface .......oooviiiiiiiiiiiiiiiiiiiciiccc 1-13
Serial Liquid Crystal Display Module Interface .........cccooveeennicnnns 1-13
Power-On-Self Test ......cueiiiiiiiiiiiiiiiiiiiiee e 1-14
Expansion Interface .......cccocoeeviiiiiiiiiiniiiiiicenecec e 1-14
Power ArchiteCture ......eiiiiiiiiiiieiiiiiee e 1-15
Power Measurements .........coeeeeeeeiiiiiiiiiiineeieeeiiiiiiiee e eeeeeeenineaen 1-15
Example Programs .........ccooceieriiieniiieiiiiceiiiceeeccee e 1-16
Reference Design Information ........cccceevviveiniiiiniiiiniiiciiiccinieens 1-16
vi ADSP-CM408F EZ-KIT Lite Evaluation System Manual



Contents

ADSP-CM408F EZ-KIT LITE HARDWARE REFERENCE

System ArchiteCture ......ccccovviiiiniiiiriiieiieceiee e 2-2
Software-Controlled Switches (SoftConfig) ......ocovvviiviiiiiniiicnninens 2-3
Overview of SoftConfig .....ccccoviiiiiiiiiiiiiiiiiiiiicceceee, 2-3
SoftConfig on the ADSP-CM408F EZ-KIT LITE ................... 2-7
Programming SoftConfig Switches ........coceiiviiiiiiiiiiiiincn 2-8
Push Buttons and Switches .....cc.oooevviiiiiiiiiiiiiiiicee e, 2-15
Boot Mode Select Switch (SW1) ..oooviiiiiiiieeeiiiiiiiicieeeeeeeee, 2-16
Reset Push Button (SW2) ooveeeiiiiieeeeeeee e 2-16
GPIO Push Buttons (SW4-5) ..uiiieiiiiiiiiiieeeiee e 2-16
Wake Push Button (SW3) ..o 2-17
JUMPEIS woiiiiiiiiiiiiiii s 2-17
VREF1 External Source Jumper (JP1) «ooccoviiiiniiiiiiiiiiienne. 2-18
Power Select Jumper (JP2) .ooocviiriiiiiiiiiicecee 2-18
Buffer Input Select Jumper (JP3) ...oooviiiiniiiiiiiiiiiiciiece 2-18
VREFO0 External Source Jumper (JP4) ..coocovvviiiiiiiiiiiiiiiiiiens 2-19
Power Jumpers (P4-7) ..coooeiiriiiiniiiiiiiieiieceec e 2-19
LEDS ettttteeeitte ettt 2-20
GPIO LEDs (LEDT—4) tooiviiiiiiiiiieeeesieee et 2-21
Reset LED (LEDS5) oiiiiiiiiiiiceeeeeee e 2-21
Ethernet Speed LED (LEDOG) ...eeeeviiiiniiiiiiiiiiiceniec e 2-21
Power LED (LED7) weviiiiiiiiiieiiiiiee e 2-22
SYS_FAULT LED (LEDS) wvoooveoooeoooeooeeoeoeeoeeeoeeeoeeeeoeeeo 2-22

ADSP-CM408F EZ-KIT Lite Evaluation System Manual

vii



Contents

CONMECTOLS wevvvitieiieiiiiiteitetetteeeeeeee et eeeeeeeeeeeeeeeeeeeeeeeeeeeeteeeeeeeeeeeeeees
Ethernet Connector (J1) coooeeeiiiiieiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeee,
RS-485 Connector (J2) oeeeevviiiiiiieeeeeeeeeeeiiieie e
DCE UART Connector (J3) ..oeuuuuveieeeeeeieiiiiiiiiiieeeeeeeeeeeviiiinnn.
Asynch or Memory Connector (J4) ....ccccoeevvvieiniieeeniieenneeenn.
Character Display Connector (J5) ...ccccoovvvieiiiiiiiniiiniiiennene.
PWM Connector (JO) .ccoeeeiiiiiiiiiiiiiieeeeeeeeeeiicceee e
CANO Connector (J7) .eueeeeeorounnnnnnnnnnnennnnnnnnnnnnnnnnnnnnnnnnnnes
CAN1 Connector (J8) .ooeeeeiiiiiiiiiiiiieeeeeeeeeeiieee e
Analog Connector (J9) ....coovviiviiiiiiiiiiiiiiiiiiicic e
JTAG/SWD Connector (P1) oovvuveiieeeeieeiiiiiiiicieeee e
TRACE and JTAG/SWD/SWYV Connector (P2) .......ccccnn......
USB Connector (P3) ..ooovuuiiiiiiiieeeiieeeeeeeeeeeee e
IEEE 1588 Connector (P8) ......uueeiiiiiiiiieiiiiiiieeeeeiieeeeeeieeee
Power Connector (P9) ...ooovueeiiiiiiiieiiiiiieeeeeiee e

VREF Buffered Connector (P10) .....covviveerniiieiniiieniieeiiieeenn
ADSP-CM408F EZ-KIT LITE BILL OF MATERIALS
ADSP-CM408F EZ-KIT LITE SCHEMATIC
INDEX

viii ADSP-CM408F EZ-KIT Lite Evaluation System Manual



PREFACE

Thank you for purchasing the ADSP-CM408F EZ-KIT Lite®, Analog
Devices, Inc. low-cost evaluation system for the ADSP-CM408F
mixed-signal control processor.

The ADSP-CM408F processor is based on the ARM® Cortex®-M4 pro-
cessor core and is designed for motor control and industrial applications.
The EZ-KIT Lite is shipped with all of the necessary hardware—you can
start the evaluation immediately. The package contains the standalone
evaluation board, CE-approved power supply, and USB cable. The
EZ-KIT Lite version ships with the J-Link Lite ARM, while the

EZ-Board® version requires the customer to provide an emulator.

Two expansion connectors (analog interface and PWM/digital interface)
are provided for connecting boards that incorporate motors. Another
expansion connector is provided for connecting an Anybus board and/or a
memory/FPGA extender card.

Traditional mechanical switches for changing the board’s factory setup
have been removed in favor of I*?C controlled software switches. The only
remaining mechanical switches are the boot mode switch and push
buttons.
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Product Overview

The evaluation board is designed to be used in conjunction with the IAR
Embedded Workbench development tools to test capabilities of the
ADSP-CM408F processors. The development environment aids advanced
application code development and debug, such as:

* Create, compile, assemble, and link application programs written
in C++, C, and assembly

* Load, run, step, halt, and set breakpoints in application programs
* Read and write data and program memory

* Read and write core and peripheral registers

Product Overview

The board features:
e Analog Devices ADSP-CM408F processor

* 176-pin LQFP package

* 30 MHz CLKIN core oscillator
e SRAM memory (SMCO) chip

e 256K x 16-bit (4M bit)

* Cypress CY7C1041DV33
e Ethernet PHY (ETHO)

e 10/100 Mb/s
¢ Texas Instruments DP83848C

X ADSP-CM408F EZ-KIT Lite Evaluation System Manual



Preface

Universal Asynchronous Receiver/Transmitter (UARTO)
* Analog Devices ADM3252E RS-232 line transceiver
* DBY female connector
Universal Asynchronous Receiver/Transmitter (UART1)
* Analog Devices ADM2682E RS-485 line transceiver
* DB9 female connector
Controller Area Network (CAN) interfaces
* CANO—Analog Devices ADM3053 transceiver and RJ11

connector

* CANI1—Analog Devices ADM3053 transceiver and RJ11

connector
USB interface
*  Molex 56579-0576 connector
Display
* New Haven NHD-0220D3Z-FL-GBW
* 2 x 20 character

e 2-wire interface (TWI) control
RESET controller

* Analog Devices ADM708 microprocessor supervisory
circuits

Debug (JTAG/SWD/SWV/TRACE) interface
e JTAG/SWD 20-pin 0.1” header for use with IAR emulators
e Trace/JTAG/SWD/SWYV 20-pin 0.05” header

ADSP-CM408F EZ-KIT Lite Evaluation System Manual x1



Product Overview

e LEDs

* Eight LEDs: one power (green), one board reset (red), one
Ethernet speed (green), one SYS_FAULT (red), and four

general-purpose (amber)
* Push buttons
* Four push buttons: one reset, one wake, two IRQ/Flag
* Asynchronous connector

* 180-pin Samtec (QSH-090-01-F-D-A) 0.5 mm spacing
e SMCO address, data, and control

« CLKOUT
 SPI1
 UART2

e TWIO

* GPIOs

* RESET

* GND/3.3V/5V output
e Pulse-width modulation (PWM) connector

* 180-pin Samtec (QSH-090-01-F-D-A) 0.5 mm spacing
s PWMO—PWM2

» SINCO
« SPI1

« SPTO
« TWIO

xil ADSP-CM408F EZ-KIT Lite Evaluation System Manual
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* TMRO

e CNTO—CNT3
* GPIO

e RESET

* GND/3.3V/5V output
* 5V output
* Analog connector interface
* 120-pin Samtec (QSH-060-01-F-D-A) 0.5 mm spacing
* ADCO
* AGND/GND/VREF/5VOUT
* ADRA441 voltage reference (VREF)
e ADA4899 buffer—0.1” header for reference

* 1588 connector

* 0.1” header 6-pin
» External power supply

* CE compliant

* 5V@3.6 Amps

* Ability to power from the PWM connector
* Other features

b OOS-Ohm resistors for processor current measurement

For information about the hardware components of the EZ-KIT Lite,
refer to ADSP-CM408F EZ-KIT Lite Bill Of Materials.
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Purpose of This Manual

Purpose of This Manual

The ADSP-CM408F EZ-KIT Lite Evaluation System Manual provides
instructions for installing the product hardware (board). The text
describes operation and configuration of the board components and pro-
vides guidelines for running your own code on the ADSP-CM408F
EZ-KIT Lite. Finally, a schematic and a bill of materials are provided for
reference.

Intended Audience

The primary audience for this manual is a programmer who is familiar
with an ARM Cortex-M4-based processor core.

The ADSP-CM40x family of mixed-signal control processors is based on
the ARM Cortex-M4 processor core with floating-point unit and inte-
grated SRAM memory, flash memory, accelerators, and peripherals.

The applicable documentation for programming the ARM Cortex-M4

processor core includes:
»  Cortex-M4 Devices Generic User Guide
»  CoreSight ETM-M4 Technical Reference Manual
»  Cortex-M4 Technical Reference Manual

For additional information on this Analog Devices processor, see the
ADSP-CM40x Mixed-Signal Control Processor Hardware Reference. This
document describes the ARM Cortex-M4 processor core and memory
architecture used on the ADSP-CM40x processor, but does not provide
detailed programming information for the ARM core.

X1v
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For more information about programming the ARM core, visit the ARM
Information Center:

http://infocenter.arm.com/help/

Manual Contents

The manual consists of:

e Chapter 1, Using ADSP-CM408F EZ-KIT Lite
Describes EZ-KIT Lite functionality from a programmer’s perspec-
tive and provides a simplified memory map of the processor.

* Chapter 2, ADSP-CM408F EZ-KIT Lite Hardware Reference
Provides information about the EZ-KIT Lite hardware
components.

e Appendix A, ADSP-CM408F EZ-KIT Lite Bill Of Materials
Provides a list of hardware components used to manufacture the

EZ-KIT Lite board.

* Appendix B, ADSP-CM408F EZ-KIT Lite Schematic
Lists the resources for board-level debugging.

What’s New in This Manual

This is Revision 1.1 of the ADSP-CM408F EZ-KIT Lite Evaluation System
Manual. Changes from Revision 1.0 include an updated Bill of Materials
and an updated schematic.
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Technical Support

Technical Support

You can reach Analog Devices processors and DSP technical support in
the following ways:

Post your questions in the processors and DSP support community
at EngineerZone™:
http://ez.analog.com/community/dsp

Submit your questions to technical support directly at:
http://www.analog.com/support

E-mail your questions about processors and processor applications
to:

processor.support@analog.com or

processor.china@analog.com (Greater China support)

In the USA only, call 1-800-ANALOGD (1-800-262-5643)

Contact your Analog Devices sales office or authorized distributor.
Locate one at:
www.analog.com/adi-sales

Send questions by mail to:

Processors and DSP Technical Support
Analog Devices, Inc.

Three Technology Way

P.O. Box 9106

Norwood, MA 02062-9106

USA

Supported Processors

This evaluation system supports Analog Devices ADSP-CM408F
processors.

xvi
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Supported Tools

Information on supported tools for the ADSP-CM408F EZ-KIT Lite and
the ADSP-CM40x family of mixed-signal control processors is available
at:

http://www.analog.com/CM408FEZKit

Product Information

Product information can be obtained from the Analog Devices Web site
and the online help system.

Analog Devices Web Site

The Analog Devices Web site, www.analog.com, provides information
about a broad range of products—analog integrated circuits, amplifiers,
converters, and digital signal processors.

To access a complete technical library for each processor family, go to
http://www.analog.com/processors/technical_library. The manuals
selection opens a list of current manuals related to the product as well as a
link to the previous revisions of the manuals. When locating your manual
title, note a possible errata check mark next to the title that leads to the
current correction report against the manual.

Also note, myAnalog.com is a free feature of the Analog Devices Web site
that allows customization of a Web page to display only the latest
information about products you are interested in. You can choose to
receive weekly e-mail notifications containing updates to the Web pages
that meet your interests, including documentation errata against all manu-
als. myAnalog.com provides access to books, application notes, data sheets,
code examples, and more.
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Notation Conventions

Visit myAnalog.com (found on the Analog Devices home page) to sign up.
If you are a registered user, just log on. Your user name is your e-mail

address.

EngineerZone

EngineerZone is a technical support forum from Analog Devices. It allows
you direct access to ADI technical support engineers. You can search
FAQs and technical information to get quick answers to your embedded
processing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar
design challenges. You can also use this open forum to share knowledge
and collaborate with the ADI support team and your peers. Visit
http://ez.analog.com to sign up.

Notation Conventions

Text conventions used in this manual are identified and described as

follows.

Example

Description

File > Close

Titles in reference sections indicate the location of an item within the
CCES environment’s menu system (for example, the Close command
appears on the File menu).

{this | that)

Alternative required items in syntax descriptions appear within curly
brackets and separated by vertical bars; read the example as this or
that. One or the other is required.

[this | that]

Optional items in syntax descriptions appear within brackets and sepa-
rated by vertical bars; read the example as an optional this or that.

[this,..]

Optional item lists in syntax descriptions appear within brackets delim-
ited by commas and terminated with an ellipse; read the example as an
optional comma-separated list of this.

xviil
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Example Description

SECTION Commands, directives, keywords, and feature names are in text with
letter gothic font.

filename Non-keyword placeholders appear in text with italic style format.

Note: For correct operation, ...
A Note provides supplementary information on a related topic. In the
online version of this book, the word Note appears instead of this

symbol.

®
N

Caution: Incorrect device operation may result if ...

Caution: Device damage may result if ...

A Caution identifies conditions or inappropriate usage of the product

that could lead to undesirable results or product damage. In the online
version of this book, the word Caution appears instead of this symbol.

N

‘Warning: Injury to device users may result if ...

A Warning identifies conditions or inappropriate usage of the product
that could lead to conditions that are potentially hazardous for the
devices users. In the online version of this book, the word Warning
appears instead of this symbol.
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1 USING ADSP-CMA408F EZ-KIT
LITE

This chapter provides information to assist you with development of pro-

grams for the ADSP-CM408F EZ-KIT Lite evaluation system.

The following topics are covered.

Package Contents

ADSP-CM408F EZ-Board

Default Configuration

IAR Embedded WorkBench and Board Installation
IAR Embedded WorkBench Session Startup
SRAM Memory (U2)

SPI Flash

Analog Interface

UARTO Interface (RS-232)

UART1 Interface (RS-485)

CANO Interface

CAN1 Interface

USB OTG FS Interface

Ethernet Interface

ADSP-CM408F EZ-KIT Lite Evaluation System Manual 1-1



Package Contents

Debug Interface

Serial Liquid Crystal Display Module Interface
Power-On-Self Test

Expansion Interface

Power Architecture

Power Measurements

Example Programs

Reference Design Information

Package Contents

Your ADSP-CM408F EZ-KIT Lite package contains the following items.

ADSP-CM408F EZ-KIT Lite board

Universal 5V DC power

USB 2.0 cable

J-Link Lite ARM (only in the EZ-KIT Lite version)

Contact the vendor where you purchased your EZ-KIT Lite or contact
Analog Devices, Inc. if any item is missing.

1-2
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Using ADSP-CM408F EZ-KIT Lite

ADSP-CM408F EZ-Board

The ADSP-CM408F EZ-KIT Lite is shipped with the J-Link Lite ARM
debugger. When the product is not shipped with the debugger, it is
referred to as the ADSP-CM408F EZ-Board.

@ The EZ-Board requires a third party emulator.

Default Configuration

The ADSP-CM408F EZ-KIT Lite board is designed to run as a stand-

alone unit.

When removing the EZ-KIT Lite board from the package, handle the
board carefully to avoid the discharge of static electricity, which can dam-
age some components.

The EZ-KIT Lite evaluation system contains ESD (electrostatic discharge)
sensitive devices. Electrostatic charges readily accumulate on the human body

and equipment and can discharge without detection. Permanent damage may A
occur on devices subjected to high-energy discharges. Proper ESD precau- \
tions are recommended to avoid performance degradation or loss of function-

ality. Store unused EZ-KIT Lite boards in the protective shipping package.

ADSP-CM408F EZ-KIT Lite Evaluation System Manual 1-3



Default Configuration

Figure 1-1 shows the default jumper settings, connector locations, and
LEDs used in installation. Confirm that your board is in the default con-
figuration before using the board.

SWi

m_ Nk =4

4
mPrS

-] JP3
T 7 JPl
O Jr4

Figure 1-1. Default EZ-KIT Lite Hardware Setup
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Using ADSP-CM408F EZ-KIT Lite

IAR Embedded WorkBench and Board

Installation
For information about the IAR Embedded WorkBench® product and
software download, go to:

http://www.iar.com/en/Products/IAR-Embedded-Workbench

The ADSP-CM408F EZ-KIT Lite software, based on the IAR Embedded
WorkBench, can be found at:

http://www.analog.com/CM408FEZKit

Follow these instructions to ensure correct operation of the product soft-
ware and hardware.

Step 1: Connect the EZ-KIT Lite board to a personal computer (PC) run-
ning IAR Embedded WorkBench using a J-Link/]J-Trace emulator.

1. Plug one side of the USB cable into the USB connector of the emu-
lator. Plug the other side into a USB port of the PC running IAR
Embedded WorkBench.

2. Attach the emulator to the header connector, P1 or P2, on the

EZ-KIT Lite board.

Step 2: Attach the provided cord and appropriate plug to the 5V power
adaptor.

1. Plug the jack-end of the power adaptor into the power connector

P9 (labeled 5V) on the EZ-KIT Lite board.

2. Plug the other side of the power adaptor into a power outlet. The
power LED (labeled LED7) is lit green when power is applied to the
board.

ADSP-CM408F EZ-KIT Lite Evaluation System Manual 1-5



IAR Embedded WorkBench Session Startup

IAR Embedded WorkBench Session
Startup

It is assumed that the JAR Embedded WorkBench software is installed

and running on your PC.

1.

Navigate to the IAR Embedded WorkBench environment via the
Start menu.

Note that JAR Embedded WorkBench is not connected to the tar-
get board.

Choose File > Open >Workspace to open a workspace for the proj-
ect to download and debug.

Choose Project > Options.

The General Options, Target page appears.

In Processor variant, ensure Device is AnalogDevices
ADSP-CM40z-X_Y, where X is the SRAM size in KB and Y is the
internal flash size in KB of the part on the target board.

On the Analog Devices ADSP-CM408F EZ-KIT Lite, SRAM size
is 384 KB, and internal flash size is 2048 KB.

1-6
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Using ADSP-CM408F EZ-KIT Lite

5. Choose Debugger in the Category pane.

The Debugger, Setup options page appears.

a.

In Driver, choose J-Link/J-Trace as the emulator to be used

to debug the target board.

Click the Download tab. The Debugger, Download options
page appears.

Ensure Use flash loader(s) is enabled. Note that other
download settings are optional.

6. Choose Debugger > J-Link/J-Trace in the Category pane.

The emulator Setup options page appears.

a.

On the Setup page,

In Reset, select Connect during reset from the drop-down
list.

In JTAG/SWD speed, select Auto.

(Optional) In Clock setup, change the default values.
On the Connection page,

In Communication, select USB and Device 0.

In Interface, select JTAG or SWD.

7. Click OK to save the emulator settings.

8. Choose Project > Debug and Download to download the project
and start debugging.

ADSP-CM408F EZ-KIT Lite Evaluation System Manual 1-7



SRAM Memory (U2)

SRAM Memory (U2)

The ADSP-CM408F processor is connected to a 4 Mb Cypress asynchro-
nous SRAM device (CY7C1041DV33). The upper and lower halves of the
16-bit-wide data bus are connected to SoftConfig circuitry, which discon-

nects the expansion interface. The connection to the expansion interface is
OFF by default.

Byte-enable signals ABEO and ABE1 on the processor’s pins PE_12 and PE_13
(respectively) are not connected by default; can be connected via

SoftConfig.

For more information, refer to the SRAM example in the POST, which is
included in the ADSP-CM40x Enablement Software.

SPI Flash

The EZ-KIT Lite ships with an internal 4 MB SPI flash, connected via the
SPI2 interface, which is used for booting and scratchpad space. Refer to
the ADSP-CM40x Mixed-Signal Control Processor Hardware Reference for

more information about the internal SPI flash.

For more information, refer to the SPI flash example in the POST, which
is included in the ADSP-CM40x Enablement Software.

Analog Interface

The ADSP-CM408F processor provides two 16-bit ADCs with 8 inputs
each, ADCO and ADC1. The ADC signals are connected to the Analog expan-
sion connector (J9). Refer to ADSP-CM408F EZ-KIT Lite Schematic for

more information.

Voltage reference for the ADC channels can be supplied internally from
the processor or externally by ADR441 ICs. U5 is the VREFO supply
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Using ADSP-CM408F EZ-KIT Lite

external source, and U47 is its VREF1 equivalent. To select the external

source for either supply, place a jumper on JP1 or JP4. Refer to
ADSP-CM408F EZ-KIT Lite Schematic for more information.

A buffered version of the voltage reference is available on J9 via a unity
gain buffer ADA4889 (U33). By default, the internal VREFO source is
selected as the input to the buffer (JP3 positions 1 and 2). If the external
voltage reference is desired, change the jumper to JP3 positions 2 and 3.

Voltage references for the analog inputs are configurable; refer to Jumpers
for more information.

UARTO Interface (RS-232)

The ADSP-CM408F processor has three built-in universal asynchronous
transmitters (UARTS). UARTO is connected to a RS-232 line transmitter.

UARTO has full RS-232 functionality via the Analog Devices ADM3252E
isolated line driver and receiver (U36).

The EZ-KIT Lite voltage isolation components are not intended
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage
isolation of any external devices/boards is the user responsibility.

Pin PC_02/UARTO_TX/TRACE_DO3/SPI0_RDY of the processor is connected to
the ADM3315 device directly and used for UART transmit.

Pin PC_01/UARTO_RX/SMCO_A05/TMO_AC15 is connected through SoftConfig
by default and used for UART receive. (This can be changed using
SoftConfig.)

By default, the UARTO CTS signal is not connected, and the UARTO RTS sig-
nal is connected to RS-232. Both connections can be changed through

SoftConfig.
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The SoftConfig switches also allow the loopback of CTS and RTS. The
UARTO CTS can be added as an input to the reset circuit through SoftCon-
fig. Refer to Software-Controlled Switches (SoftConfig) for more
information.

For more information, refer to the UARTO example in the POST, which
is included in the ADSP-CM40x Enablement Software. Note that the

loopback of TX and RX data is done through an external connector.

UART1 Interface (RS-485)

UART1 is connected to a RS-485 line transmitter. UART1 has full RS-485
functionality via the Analog Devices ADM2682E isolated line driver and
receiver (U39) that can transmit at 16 Mbps.

The EZ-KIT Lite is designed to be the end node in a network; therefore, it
has a termination resistor (R44) installed with a value of 120 ohms. If the
board is intended to be a middle node in the network, the resistor can be
removed.

The EZ-KIT Lite voltage isolation components are not intended
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage
isolation of any external devices/boards is the user responsibility.

The UART1 transmit and receive signals are connected to the RS-485 trans-
mitter directly from the processor. The ADM2682E device has driver
enable and receiver enable signals, controlled by SoftConfig. The driver
enable and receiver enable signals are disabled by default. Refer to Soft-
ware-Controlled Switches (SoftConfig) for more information.

For more information, refer to the UART1 example in the POST, which
is included in the ADSP-CM40x Enablement Software. Note that the
loopback of the differential signals is done through an external connector.
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CANDO Interface

The Controller Area Network 0 (CANO) interface of the EZ-KIT Lite is
connected to the Analog Devices ADM3053 isolated CAN transceiver.
The transceiver is attached to the CANO port of the ADSP-CM408F proces-
sor via an RJ-11 connector (J7). See CANO Connector (J7).

The EZ-KIT Lite voltage isolation components are not intended
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage
isolation of any external devices/boards is the user responsibility.

The CANO transmit and receive signals are connected through the SoftCon-
fig switches and enabled by default. See Software-Controlled Switches
(SoftConfig).

For more information, refer to the CANO example in the POST, which is
included in the ADSP-CM40x Enablement Software.

CAN1 Interface

The Controller Area Network 1 (CAN1) interface of the EZ-KIT Lite is
connected to the Analog Devices ADM3053 isolated CAN transceiver.
The transceiver is attached to the CAN1 port of the ADSP-CM408F proces-
sor via an RJ-11 connector (J8). See CAN1 Connector (J8).

The EZ-KIT Lite voltage isolation components are not intended
for protecting external products. The isolated ICs are used to show-
case Analog Devices product portfolio only. Adequate voltage
isolation of any external devices/boards is the user responsibility.

The CAN1 transmit and receive signals are connected through the SoftCon-
fig switches and enabled by default. See Software-Controlled Switches
(SoftConfig).
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For more information, refer to the CAN1 example in the POST, which is
included in the ADSP-CM40x Enablement Software.

USB OTG FS Interface

The ADSP-CM408F processor has an integrated USB PHY; the EZ-KIT
Lite provides a mini AB connector. The board only supports USB full
speed mode.

The board allows 5V at 500 mA to a peripheral device by enabling the
FET switch (U44). The USB controller controls the FET switch through
the USB_VBC signal.

To learn about the processor’s device and host modes, refer to the USB
example in the POST, which is included in the ADSP-CM40x Enable-
ment Software. For more information, refer to the ADSP-CM40x
Mixed-Signal Control Processor Hardware Reference.

Ethernet Interface

The ADSP-CM408F processor features a Reduced Media Independent
Interface (RMII), which connects to an external Ethernet PHY device
(ETHO). The EZ-KIT Lite provides a Texas Instruments DP83848C,
Auto-MDIX, fully-compliant PHY with IEEE 802.2/802.2u standards.

The PHY supports 10BASE-T and 100BASE-TX operations and is con-
nected to a standard RJ-45 connector (J1). The IEEE 1588 time stamping
signals can be probed on connector P8. For more information, see Ether-
net Connector (J1) and IEEE 1588 Connector (P8). Link and activity
LEDs are integrated into the RJ45 connector. The speed indication LED
(LED6) is located next to the RJ45 connector. See Ethernet Speed LED
(LEDG®).
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The MAC address is printed on the back of the EZ-KIT Lite board; the

address must be set in software to use the Ethernet.

The Ethernet PHY device is disabled via SoftConfig. Refer to Soft-

ware-Controlled Switches (SoftConfig) for more information.

For more information, refer to the ethernet example in the POST, which
is included in the ADSP-CM40x Enablement Software.

Debug Interface

The EZ-KIT Lite provides a JTAG/SWD/SWV connection via a connec-
tor (P1), which is a 0.1” header. A 4-bit trace connection also is available
via a connector (P2). See JTAG/SWD Connector (P1) and TRACE and
JTAG/SWD/SWV Connector (P2) for more information.

Serial Liquid Crystal Display Module
Interface

Connector J5 mates with the Newhaven Display International
NHD-0220D3Z-FL-GBW-V3, a 2-line by 20-character display with a
yellow/green backlight.

The display is written using the TWI interface. The TWI address of the
display is 0x50. The maximum clock rate for the display is 100 kHz. The
display can be removed if the frequency limitation poses a problem.

For more information, refer to the serial liquid crystal display example in

the POST, which is included in the ADSP-CM40x Enablement Software.
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Power-On-Self Test

The Power-On-Self-Test Program (POST) tests all EZ-KIT Lite peripher-
als and validates functionality as well as connectivity to the processor.
Once assembled, each EZ-KIT Lite is fully tested for an extended period
of time with POST. All EZ-KIT Lite boards are shipped with POST pre-
loaded into flash memory. The POST is executed by resetting the board
and pressing the proper push button(s). The POST also can be used as a

reference for a custom software design or hardware troubleshooting.

Note that the source code for the POST program is included in the
ADSP-CM40x Enablement Software along with the readme. txt file that
describes how the board is configured to run POST.

Expansion Interface

The expansion interface allows a custom-design daughter board to be
tested across various hardware platforms that have the same expansion
interface.

The expansion interface implemented on the ADSP-CM408F EZ-KIT
Lite consists of three connectors: Asynch or Memory Connector (J4),
PWM Connector (J6), and Analog Connector (J9). The connectors con-
tain a majority of the processor’s signals. For pinout information, go to

ADSP-CM408F EZ-KIT Lite Schematic.

Limits to current and interface speed must be taken into consideration
when using the expansion interface. Current for extenders connected to J4
or J6 can be sourced from the EZ-KIT Lite; therefore, the current should
be limited to 250 mA for 5V, and 200 mA from the 3.3V planes. If more
current is required, a separate power connector and a regulator must be
designed on the daughter card. Additional circuitry implemented on
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extender cards can add extra loading to signals, decreasing their maximum
effective speed.

Analog Devices does not support and is not responsible for the
effects of additional circuitry.

Power Architecture

The ADSP-CM408F EZ-KIT Lite has two primary voltage domains: 3.3V
and 1.2V. The main input is a 5V wall adaptor. The 5V source can be
selected via JP2 to input from the PWM connector (J6) as an alternative
to the wall power adaptor. Refer to PWM Connector (J6) and Power
Select Jumper (JP2) for details.

The Analog Devices ADP2119 controller provides 3.3V for the VDD_EXT
signal and the 3.3V power requirements of the board. The VDD_INT signal
is delivered through either Analog Devices regulator ADP2119 (VR1) or a
PNP transistor (Q1).

A FET switch (U44) controls the 5V to the USB devices over the USB_VBUS
signal.

Power Measurements

Locations are provided for measuring the current draw from various power
planes. Precision 0.05 ohm shunt resistors are available on the VDD_EXT,
VDD_INT, USB_VBUS, and 3.3V and voltage domains. For current draw, the
jumper is removed, voltage across the resistor can be measured using an
oscilloscope, and the value of the resistor can be measured using a preci-
sion multi-meter. Once voltage and resistance are measured, the current
can be calculated by dividing the voltage by the resistance. For the highest
accuracy, a differential probe should be used for measuring the voltage
across the resistor. For more information, refer to Power Jumpers (P4-7).
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Example Programs

Example programs are provided with the ADSP-CM40x Enablement Soft-
ware to demonstrate various capabilities of the product. The programs can
be found in the CM403F_CM408F_EZ-KIT\examples folder. Refer to a
readme file provided with each example for more information.

Reference Design Information

A reference design info package is available for download on the Analog
Devices Web site. The package provides information on the design, lay-
out, fabrication, and assembly of the EZ-KIT Lite.

The information can be found at:

http://www.analog.com/CM408FEZKit
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2 ADSP-CM408F EZ-KIT LITE
HARDWARE REFERENCE

This chapter describes the hardware design of the ADSP-CM408F
EZ-KIT Lite board.

The following topics are covered.

System Architecture
Describes the board’s configuration and explains how the board
components interface with the processor.

Software-Controlled Switches (SoftConfig)
Lists and describes the processor signals routed through the soft-
ware-controlled switches.

Push Buttons and Switches
Shows the locations and describes the push buttons and switches.

Jumpers
Shows the locations and describes the configuration jumpers.

LEDs
Shows the locations and describes the LEDs.

Connectors

Shows the locations and provides part numbers for the on-board
connectors. In addition, the manufacturer and part number infor-
mation is provided for the mating parts.
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System Architecture

This section describes the processor’s configuration on the EZ-KIT Lite
board (Figure 2-1).

t t Tl
RS-232 RS-485 DP83848
Ethernet| |, AD! ADI
ADM3252E | |ADM2682 PHY | IADM3053| |ADM3053
30 MHz

Oscillator

B ‘UARTO‘ ‘UART1 ‘ ‘ USBO ‘ ‘ ETHO ‘ ‘ CANO ‘ ‘ CAN1 ‘ ‘ SPI2 ‘ »
P LEDs (4)
ADSP-CM408F -
SPI Flash

SRAM
28 .ﬂgu?'st ﬁiﬁs TMRO 2 SMCO | g 4 Mbit Cypress
‘ CY7C1041DV33

‘ SPTO PWM02
-<_‘

Figure 2-1. EZ-KIT Lite Block Diagram

GPIO

AFE

/

‘ SINCO HCNTO3‘ ‘ TWIO ‘ ‘UARTZ‘

This EZ-KIT Lite is designed to demonstrate the ADSP-CM408F proces-
sor’s capabilities. The ADSP-CM408F EZ-KIT Lite has a 30 MHz input
clock and runs at 240 MHZ internally.

USB circuitry and a mini USB AB connector are provided for connecting
to the EZ-KIT Lite as a host or a device. The frequency for the USB cir-
cuit is generated internally to the processor.
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User I/O to the processor is provided in the form of two user push buttons
and four LEDs. The software-controlled switches (SoftConfig) facilitate
the switch multi-functionality by disconnecting the push buttons from
their associated processor pins and reusing the pins elsewhere on the
board. See ADSP-CM408F EZ-KIT Lite Schematic for more information.

Software-Controlled Switches
(SoftConfig)

On the ADSP-CM408F EZ-KIT Lite, most of the traditional mechanical
switches have been replaced by [2C software-controlled switches. The
remaining mechanical switches are provided for the boot mode and push
buttons. Reference any SoftConfig*.c file found in the installation direc-
tory for an example of how to set up the SoftConfig feature of the

ADSP-CM408F EZ-KIT Lite through software.

The SoftConfig section of this manual serves as a reference to any user
that intends to modify an existing software example. If software provided
from ADI is used, there should be little need to reference this section.

Care should be taken when changing SoftConfig settings not to
create a conflict with interfaces. This is especially true when con-
necting extender cards.

Overview of SoftConfig

In order to further clarify the use of electronic single FET switches and
multi-channel bus switches, an example of each is illustrated and com-
pared to a traditional mechanical switching solution. This is a generic

example that uses the same FET and bus switch components that are on
the EZ-KIT Lite.

After this generic discussion there is a detailed explanation of the Soft-

Config interface specific to the ADSP-CM408F EZ-KIT Lite.
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Figure 2-2 shows two individual FET switches (Pericom PI3A125CEX)
with reference designators UA and UB. Net names ENABLE_A and ENABLE_B
control UA and UB. The default FET switch enable settings in this exam-
ple are controlled by resistors RA and RB which pull the enable pin 1 of UA
and UB to ground (low). In a real example, these enable signals are con-
trolled by the Microchip IO expander. The default pull-down resistors
connects the signals EXAMPLE_SIGNAL_A and EXAMPLE_SIGNAL_B and also
connects signals EXAMPLE_SIGNAL_C and EXAMPLE_SIGNAL_D. To disconnect
EXAMPLE_SIGNAL_A from EXAMPLE_SIGNAL_B, the Microchip IO expander is
used to change ENABLE_A to a logic 1 through software that interfaces with
the Microchip. The same procedure for ENABLE_B would disconnect EXAM-
PLE_SIGNAL_C from EXAMPLE_SIGNAL_D.

UA
ENABLE_A = I5g
EXAMPLE_SIGNAL A m A B m EXAMPLE SIGNAL B
TATIS
SC70 5
UB
ENABLE B ® Be
EXAMPLE_SIGNAL C = i B @ EXAMPLE SIGNAL D
TATIS
SC70 5
>RA >RB
0K \_?*WOK
<, 0402, 0402

.

NS

Figure 2-2. Example of Individual FET Switches
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Figure 2-3 shows the equivalent circuit to Figure 2-2 but utilizes mechan-
ical switches that are in the same package. Notice the default is shown by
black boxes located closer to the 0N label of the switches. In order to dis-
connect these switches, physically move the switch to the 0FF position.

SWA
EXAMPLE_SIGNAL A m— 1 [ JE ' m EXAMPLE_SIGNAL B
[ |

EXAMPLE_SIGNAL_C m—2&.

DIP2
SWT020

F—a EXAMPLE_SIGNAL_D

Figure 2-3. Example of Mechanical Switch Equivalent to Figure 2-2

Figure 2-4 shows a bus switch example, reference designator UC (Pericom
PI3BLVD512ZHE), selecting between lettered functionality and numbered
functionality. The signals on the left side are multiplexed signals with
naming convention letter_number. The right side of the circuit shows the
signals separated into letter and number, with the number on the lower
group (eg. 0B1) and the letter on the upper group (eg. 082). The default
setting is controlled by the signal CONTROL_LETTER_NUMBER which is pulled
low. This selects the number signals on the right to be connected to the
multiplexed signals on the left by default. In this example, the Microchip
IO expander is not shown but controls the signal CONTROL_LETTER_NUMBER
and allows the user to change the selection through software.

Figure 2-5 shows the equivalent circuit to Figure 2-4 but utilizes mechan-
ical switches. Notice the default for reference designators SWC and SWD is
illustrated by black boxes located closer to the 0N label of the switches to
enable the number signals by default. Also notice the default setting for
reference designators SWE and SWF is OFF. In order to connect the letters
instead of the numbers, the user physically changes all switches on SWC and
SWD to the OFF position and all switches on SWE and SEF to the ON position.
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Figure 2-5. Example of Mechanical Switch Equivalent to Figure 2-4

SoftConfig on the ADSP-CM408F EZ-KIT LITE

Two Microchip MCP23017 GPIO expanders provide control for individ-
ual electronic switches. The TWIO interface of the processor
communicates with the Microchip devices. There are 33 individual
switches with default settings that enable basic board functionality.

Table 2-1 lists the ADSP-CM408F processor and EZ-KIT Lite interfaces
that are available by default. Note that only interfaces affected by software
switches are listed in Table 2-1.
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Table 2-1. Default ADSP-CM408F Processor Interface Availability

Interface Availability by Default

UARTO RS-232 RX, TX and RTS enabled by default. SoftConfig required for other
functionality.

UART1 RS-485 is connected by default but not enabled. SoftConfig is required to
enable.

CANO Enabled

CAN1 Enabled

EMACO RMII interface, management data input/output and 50 MHz oscillator
disabled by default. PHYINT disconnected from processor by default.

Push buttons Enabled (except for wake push button)

LEDs Enabled

Programming SoftConfig Switches

On the ADSP-CM408F EZ-KIT Lite, two Microchip MCP23017 devices
exist. Each of these devices have the following programming
characteristics:

* Each switch has two programmable GPIO registers.

GPIO Register Register Address
GPIOA 0x12
GPIOB 0x13

* Each GPIO register controls eight signals (software switches).
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By default, the Microchip MCP23017 GPIO signals function as

input signals.

The signals must be programmed as output signals to override their
default values. The following table shows the Microchip register
addresses and the values that must be written to them to program
the signals as output signals.

IODIR Register |IODIR Register Address |Value to be Written to Program Signals
as Outputs

IODIRA 0x00 0

IODIRB 0x01 0

Each of the examples in the ADSP-CM40x Enablement Software include
source files that program the soft switches, even if the default settings are
being used. The README for each example identifies only the signals that
are being changed from their default values. The code that programs the
soft switches is located in the SoftConfig_CM408F.c file in each example.

The following tables (Table 2-2 and Table 2-3) outline the default values
for each of the two Microchip MCP23017 devices.

Table 2-2. I2C Hardware Address 0x40

GPIO MCP23017 Register Address Default Value
GPIOA 0x12 0xEO0
GPIOB 0x13 0x00

Table 2-3. I2C Hardware Address 0x42

GPIO MCP23017 Register Address Default Value
GPIOA 0x12 0xB9

GPIOB 0x13 0x3F
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The ADSP-CM408F EZ-KIT Lite Schematic shows how the two Micro-
chip GPIO expanders are connected to the board’s ICs.

Table 2-4 and Table 2-5 show the output signals of the Microchip GPIO
expander (U40), with a TWI address of 0100 001X, where X represents the
read or write bit. The signals that control an individual FET have an entry
under the FET column. The Component Connected column shows the

board IC that is connected if the FET is enabled. The Microchip (U40) is
controlling the enable signal of a FET switch. Also note that if a particular

functionality of the processor signal is being used, it will be in bold font
under the Processor Signal column.

Table 2-4. Output Signals of Microchip GPIO Expander

(U40 Port A)

disconnected from
RS-232 transceiver
by default

UARTO_CTS/TMO_T -
MR7/SMCO_D13/
CNT1_DG

Bit |Signal Name Description FET | Processor Signal Component | Default
(if applicable) Connected
0 Not used Low
1 Not used Low
2 Not used Low
3 UARTORTS_EN UARTO RTS U13 | PB_04/PWM2_SYNC/ U36 Low
connected to RS-232 UARTO_RTS/
transceiver SPTO_ATDV/
SMCO_D12/CNT1_UD
4 UARTORX_EN UARTO0 RX Ul4 [ PC_O1/UARTO_RX/ U36 Low
connected to RS-232 SMCO_AO05/TMO_ACI5
transceiver
5 UARTOCTS_EN UARTO CTS U1l5 [ PB_05/PWM2_TRIPO/ U36 High
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Table 2-4. Output Signals of Microchip GPIO Expander
(U40 Port A) (Contd)

Bit |Signal Name Description FET |Processor Signal Component | Default
(if applicable) Connected
6 UARTOCTS_RTS_LPBK | UARTO CTS and Ule U36 Pﬁgh

RTS not connected;
change to low for
looping back RS-232
CTS and RTS signals

7 UARTOCTS_RST_EN UARTO CTS Signal u17z U36 High
not connected to
input of reset IC

Table 2-5. Output Signals of Microchip GPIO Expander
(U40 Port B)

Bit|Signal Name Description FET |Processor Signal |Component |Default
(if applicable) Connected
0 | CANO_EN Enables CAN 0, 18/ | PC_00/CANO_TX/ | U39 Low
enabled by default ul9 | SPT1_BTDV/
UART1_TX/
SMCO_AO4 and
PB_15/CANO_RX/
SPT1_ATDV/
UARTI_RX/
SMCO_AO3/TMO_A-
CI4
1 | PUSHBUTTONI_EN | PF_10 is used as GPIO | U31 | PF_10/ETHO_PTP- | U39 Low
input for push button CLKIN
1, enabled by default
2 | PUSHBUTTONZ_EN PE_08 is used as GPIO | U30 PE_08/ U39 Low
input for push button ETHO_PTPPPS/
2, enabled by default SMCO_A22/
CNT2_ZM
3 | LEDI_GPIO_EN PE_07 is used as GPIO | U28 | PE_07/ETHO_PT- | U5 Low
output for LEDI, PAUXIN/SMCO_A21
enabled by default
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Table 2-5. Output Signals of Microchip GPIO Expander

(U40 Port B) (Cont’d)

Bit|Signal Name Description FET |Processor Signal Component | Default
(if applicable) Connected

4 | LED2_GPIO_EN PE_06 is used as GPIO |U27 PE_06/SMCO_A20 | U5 Low
output for LED2,
enabled by default

5 | LED3_GPIO_EN PE_05 is used as GPIO | U26 PE_05/SMCO0_A19 | U5 Low
output for LED3,
enabled by default

6 | LED4_GPIO_EN PE_09 is used as GPIO | U25 PE_09/ETHO_CRS/ | U5 Low
output for LED4, SMCO_A23/
enabled by default CNT2_UD

7 Not used

Table 2-6 and Table 2-7 show the output signals of the Microchip GPIO
expander (U41), with a TWI address of 0100 010X, where X represents the
read or write bit. The signals that control an individual FET have an entry
under the FET column. The Component Connected column shows the
board IC that is connected if the FET is enabled. Note that some of the
Microchip (U41) output signals are connected directly to components on
the board. However, in most cases, the Microchip (U41) is controlling the
enable signal of a FET switch. Also note that if a particular functionality
of the processor signal is being used, it will be in bold font under the Pro-
cessor Signal column.
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Table 2-6. Output Signals of Microchip GPIO Expander

(U41 Port A)

ADSP-CM408F EZ-KIT Lite Hardware Reference

Bit |Signal Name Description FET/ Processor Signal Component | Default
SWITCH | (if applicable) Connected
0 RS485_RE Controls RS-485 U39 High
receiver enable
1 RS485 DE Controls RS-485 U39 Low
driver enable
2 CANI_EN Enables CAN 1, U20/U21 | PB_11/SINCO_DO/ u37 Low
enabled by default SPI0_D3/CAN1_TX/
SMCO_AMSO/TMO_A-
CLK1 and PB_10/
SINCO_CLKO/
SPI0_D2/CAN1_RX/
SMCO_AWE/TMO_ACI1
3 ETHO_MDIO_BUS_EN Connects Ethernet U22/U23 | PE_11/ETHO_MDC/ U43 High
management data SMCO_A24/CNT3_ZM
input/output, dis- and PE_10/ETH_M-
abled by default DIO/SMCO_AMS1/
CNT2_DG
4 ETHERNET_EN Connects ETHO to U3z PF_00, PF_01, u43 High
RMII interface of PE_12, PE_13,
U32, by default PE_14, PE_09
disabled
5 | PHYINT_EN! Connects Ethernet 0 | U24 PC_06/SPIO_SELL/ |U43 High
interrupt signal to PWM2_DL/SYS_D-
Ethernet PHY, not SWAKEO
connected by default
6 RMIT_CLK_EN Enables 50 MHz PE_15/ETHO_REF- u3s Low
oscillator, disabled by CLK/CNT1_OUTB
default
7 WAKE_PUSHBUTTON_EN Conncctsproccssorto u29 PC_06/SPI0_SEL1/ High
wake push button, PWM2_DL/SYS_D-
disabled by default SWAKEO_ACLKS
1 This signal is actually active low.
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Software-Controlled Switches (SoftConfig)

(U41 Port B)

Table 2-7. Output Signals of Microchip GPIO Expander

Bit |Signal Name Description FET/ Processor Signal Component | Default
SWITCH | (if applicable) Connected
0 | DATA_LOW_EXP_EN Connects signals to U1z PC_08, PC_09, J6 High
expansion interface PC_10, PC_11,
connector J6, PC_12, PC_13,
disconnected by default PC-14, PC_I5
1 | DATA_HIGH_EXP_EN | Connects signals to U1l PD_00, PD_01, J6 High
expansion interface PD_02, PD_03,
connector J6, PD_04, PD_05,
disconnected by default PD_06, PD_07
2 | TRACE_EXP_EN Connects signals to Us1, PE_12, PE_13, J6 High
expansion interface us2, PE_09, PE_11,
connector J6, us3, PE_10
disconnected by default us4,
Ub5s
3 PB_08_09_EXP_EN Connects signals to U49/U50 PB_08/PWM2_BH/ Jé High
expansion interface TMO_TMR1/
connector J6, UARTI_RX/
disconnected by default SMCO_ARDY/
TMO_ACI2
and
PB_09/PWM2_BL/
TMO_TMR2/
UART1_TX/
SMCO_ARE
4 | ETH_EXP_EN Connects signals to Us6, PE_12, PE_13, J4 High
expansion interface us7, PE_09, PE_11,
connector J4, uss, PEIO
disconnected by default Us9,
U60
5 SRAM_BYTE_EN Connects SRAM ABEO/ | U4, U7 PE_12, PE_13 U2 High
1 signals to SRAM
6 Not used Low
7 Not used Low
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ADSP-CM408F EZ-KIT Lite Hardware Reference

Push Buttons and Switches

This section describes operation of the push buttons and switches. The
push button and switch locations are shown in Figure 2-6.

O]

SV SWi

SW3

i

Sw4 NS

Figure 2-6. Push Button and Boot Mode Switch Locations
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Push Buttons and Switches

Boot Mode Select Switch (SW1)

The rotary switch (SW1) determines the boot mode of the processor.
Table 2-8 shows the available boot mode settings. By default, the
ADSP-CM408F processor boots from the internal SPI flash memory.

Table 2-8. Boot Mode Select Switch (SW1)

SW1 Position Processor Boot Mode

0 No Boot — Idle

1 SPI master boot (internal SP12). Default boot mode.

2 SPI slave boot (SPI0)

3 UART boot (UARTO0)

Reset Push Button (SW2)

The reset push button (SW2) resets the following ICs: processor (U1),
GPIO extender (U40), GPIO extender (U41), and Ethernet PHY (U43).

The reset also is connected to the expansion interface via the SYS_HWRST
signal.

GPIO Push Buttons (SW4-5)

The GPIO push buttons (SW4 and SW5) are connected to the processor’s
signals PF_10/ETHO_PTPCLKIN and PE_08/ ETHO_PTPPPS/SMCO_A22/CNT2_1ZM,
respectively. The signals are connected by default.
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ADSP-CM408F EZ-KIT Lite Hardware Reference

Wake Push Button (SW3)

The wake push button (SW3) is connected to the processor’s signal
PC_06/SPTO_SELT/PWM2_DL/SYS_DSWAKEO. The signal is disconnected by
default through SoftConfig.

Jumpers

This section describes functionality of the configuration jumpers.
Figure 2-7 shows the jumper locations.

O ope O] P4

O p7
Odps

O_10r3
O uP1
(O Jp4

Figure 2-7. Jumper Locations
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Jumpers

VREF1 External Source Jumper (JP1)

The VREF1 external source jumper (JP1) selects whether an internal or
external voltage reference supplies the VREF1 signal of the processor. When
a jumper on JP1 is not installed (default), the internal voltage reference
supplies VREF1. When a jumper on JP1 is installed, the external Analog
Devices ADR441 ultra-low noise voltage reference (U47) supplies VREF1.
Configure the processor’s registers accordingly for the latter case.

Power Select Jumper (JP2)

The power select jumper (JP2) selects the wall power (5V) when a jumper
is placed on positions 1 and 2. When a jumper is placed on positions 2
and 3, power from pins 177, 178, 179 and 180 of the PWM connector
(J6) is supplied to the board. The default setting is positions 1 and 2,
which selects wall power.

Buffer Input Select Jumper (JP3)

The buffer input select jumper (JP3) selects the input to the ADA4889
unity gain op amp buffer (U33). The processor’s internal input is selected
by placing a jumper on pins 1 and 2 of JP3 (default).

The external VREFO input, supplied by the Analog Devices ADR441
ultra-low noise voltage reference (U6), is selected by placing a jumper on
pins 2 and 3 of JP3.
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VREFO External Source Jumper (JP4)

The VREFO external source jumper (JP4) selects whether an internal or
external voltage reference supplies the VREFO signal of the processor. When
a jumper on JP4 is not installed (default), the internal voltage reference
supplies VREF0. When a jumper on JP4 is installed, the external Analog
Devices ADR441 ultra-low noise voltage reference (U6) supplies VREFO.
Configure the processor’s registers accordingly for the latter case.

Power Jumpers (P4-7)

Remove jumpers listed in Table 2-9 to measure the respective voltage
across the adjacent sense resistor.

Table 2-9. Power Jumpers

Power Jumper Resistor
P4 USB_VBUS
P5 VDD_EXT
P6 VDD_INT
p7 3.3V
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LEDs

LEDs

This section describes the on-board LEDs. Figure 2-8 shows the LED

locations.
LEDS
oo
oo [ams)
LED7 LEDS
oo

LED6

LEDs
[0 (00 (0 000

1234

Figure 2-8. LED Locations
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GPIO LEDs (LED1-4)

Four LEDs are connected to the general-purpose 1/O pins of the processor
(see Table 2-10). The LEDs are active high and are 0N (amber) by writing
a 1 to the correct processor signal.

Table 2-10. GPIO LEDs

LED Reference Designator Processor Programmable Flag Pin
LED1 PE_07
LED2 PE_06
LED3 PE_05
LED4 PE_09

Reset LED (LED5)

When LED5 is ON (red), it indicates that the master reset of all the major
ICs is active. The reset LED is controlled by the Analog Devices ADM708
supervisory reset circuit. A master reset is asserted by pressing SW2 which
activates LED5. For more information, see Reset Push Button (SW2).

Ethernet Speed LED (LED6)

The Ethernet speed LED (LED6) is a green LED that shows the connection
speed when the Ethernet is enabled. When LED6 is 0N, the speed is 100
Mb/s; when LED6 is OFF, the speed is 10 Mb/s. For more information, see
Ethernet Interface.
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LEDs

Power LED (LED7)

When LED7 is ON (green), it indicates that power is being supplied to the
board properly. For more information, see Power Architecture.

SYS_FAULT LED (LEDS)

When SYS_FAULT LED LEDS8 (red) is ON, it indicates a system fault. For
more information, refer to the ADSP-CM40x Mixed-Signal Control Proces-

sor Hardware Reference.
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ADSP-CM408F EZ-KIT Lite Hardware Reference

This section describes connector functionality and provides information

about mating connectors. The connector locations are shown in
Figure 2-9.

JS

ng

J1

P8

P3

P1 |

J3

L

L

Je

[

pe

J7

J8

P10

Jé

199

J4

Figure 2-9. Connector Locations

@ Connectors on the back of the board are noted with dotted lines.
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Connectors

Ethernet Connector (J1)

Part Description Manufacturer Part Number
RJ45 PULSE ELECTRONICS JOO11D21BNL
Mating Cable
Standard Ethernet cable

RS-485 Connector (J2)

Part Description Manufacturer Part Number

DBY female NORCOMP 191-009-213-L-571

DCE UART Connector (J3)

Part Description Manufacturer Part Number

DB9 female NORCOMP 191-009-213-L-571

Asynch or Memory Connector (J4)

Part Description Manufacturer Part Number

180-pin high speed socket SAMTEC QSH-090-F-D_A

Mating Connector

180-pin high speed header SAMTEC QTH-090-01-F-D-A

2-24 ADSP-CM408F EZ-KIT Lite Evaluation System Manual




ADSP-CM408F EZ-KIT Lite Hardware Reference

Character Display Connector (J5)

The character display connector (J5) is a socket that mates with the 20 x 2
character display.

Part Description Manufacturer Part Number

IDC 5x2 SMT SAMTEC SSW-105-22-F-D-VS

Mating Connector

20x2 character display with back- NEW HAVEN DISPLAY | NHD-0220D3Z-FL-GBW
light (requires header)

PWM Connector (J6)

Part Description Manufacturer Part Number

180-pin high speed socket SAMTEC QSH-090-F-D_A

Mating Connector

180-pin high speed header SAMTEC QTH-090-01-F-D-A

CANO Connector (J7)

Part Description Manufacturer Part Number

RJ11 vertical DIGIKEY A31431-ND

Mating Connector

RJ11 cable
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Connectors

CAN1 Connector (J8)

Part Description Manufacturer Part Number

RJ11 vertical DIGIKEY A31431-ND

Mating Connector

RJ11 cable
Analog Connector (J9)
Part Description Manufacturer Part Number
120-pin high speed socket SAMTEC QSH-060-F-D_A

Mating Connector

120-pin high speed header SAMTEC QTH-060-01-F-D-A

JTAG/SWD Connector (P1)

The JTAG/SWD/SWYV header (P1) provides debug connectivity for the
microprocessor. This is a 0.1” connector from SAMTEC
(SHF-110-01-L-D-TH). For more information, see Debug Interface.

TRACE and JTAG/SWD/SWV Connector (P2)
The TRACE and JTAG/SWD/SWV Connector (P1) provides connectiv-

ity to the microprocessor’s trace interface. This is a 0.05” connector from

TE Connectivity (5103308-5).
Pin 7 is cut to provide keying.

Refer to the SoftConfig tables for information on enabling the Trace sig-
nals, specifically the TRACE_EXP_EN signal.
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USB Connector (P3)

USB FS only mode.

Part Description Manufacturer Part Number

USB mini-B MOLEX 56579-0576

IEEE 1588 Connector (P8)

P8 allows probing of Ethernet IEEE 1588 signals. P8 is a 0.1” header and
the pinout can be found in ADSP-CM408F EZ-KIT Lite Schematic.

Power Connector (P9)

Part Description Manufacturer Part Number

0.65 mm power jack CUI 045-0883R

Mating Connector

5.0VDC@3.6A power supply GLOBETEK GS-1750(R)

VREF Buffered Connector (P10)

The VREF buffered connector provides a means to measure the voltage of
the voltage reference. There is an adjacent analog grounding point (TP13).
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A ADSP-CM408F EZ-KIT LITE
BILL OF MATERIALS

The bill of materials corresponds to ADSP-CM408F EZ-KIT Lite

Schematic.
Ref. | Qty. | Description Reference Manufacturer Part Number
Designator
1 1 ADM708SARZ SOICS8 U42 ANALOG ADM708SARZ
DEVICES

2 2 ADR441ARMZ U6,U47 ANALOG ADR441ARMZ
MSOP8 DEVICES

3 1 ADP2118ACPZ VR2 ANALOG ADP2118ACPZ
QFN65P400X400X80- DEVICES
17N

4 1 ADP2119ACPZ-R7 VR1 ANALOG ADP2119ACPZ-R7
DFEN50P300X300-11N DEVICES

5 1 ADA4899 SOICS U33 ANALOG ADA4899-1YRDZ-R7

DEVICES

6 1 ADM2682E U39 ANALOG ADM2682EBRIZ
SOIC127P1032X265-1 DEVICES
6N

7 1 ADM3252E U36 ANALOG ADM3252EABCZ
BGA44C100P11X11_1 DEVICES
200X1200X103

8 2 ADM3053 U37,U38 ANALOG ADM3053BRWZ
SOIC127P1032X265-2 DEVICES
0N

9 1 ADSP-CM408BSWZ Ul ANALOG ADSP-CM408FBSWZENG
LQFP176_EP DEVICES
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Ref.

Qty.

Description

Reference
Designator

Manufacturer

Part Number

10

62

0.1UF 10V 10% 0402

C1,C5-C7,C1
7,C18,C22,C2
5,C26,C29,C3
1,C34-C36,C4
0,C43,C45,C4
8,C50,C54-C5
6,C59,C60,C6
2-C65,C67,C6
8,C72,C78,C7
9,C101,C102,
C104,C109,C1
19,C120,C122
-C125,C128-C
130,C132,C13
5,C136,C138,
C139,C143,C1
48-C150,C153
-C157,C174,C
179

AVX

0402ZD104KAT2A

11

74

0.01UF 16V 10% 0402

C2,C8,C9,C19
-C21,C24,C30
,C32,C33,C46
,C47,C49,C51
,C53,C61,C66
,C69-C71,C73
-C76,C80-C90
,C92,C110-C1
18,C121,C131
,C134,C141,C
144,C151,C15
2,C158-C173,
C175-C178,C
180,C181

AVX

0402YC103KAT2A

12

4.7UF 25V 20% 0805

C142

AVX

0805ZD475KAT2A

13

10UF 16V 10% 1210

C98

AVX

1210YD106KAT2A

14

1000PF 50V 5% 1206

C97,C99

AVX

12065A102JAT2A
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ADSP-CM408F EZ-KIT Lite Bill Of Materials

Ref. | Qty. | Description Reference Manufacturer Part Number
Designator
15 2 680 1/16W 1% 0402 R210,R211 BC 2312275 16801
COMPONENTS

16 1 1.5UH 20% INDO003 L2 COIL CRAFT DO1608C-152MLC

17 1 1.5UH 20% L1 COILCRAFT XAL4020-152MEB
INDC4040X210N

18 |1 ROTARY SWT027 SW1 COPAL S-8110

19 |1 CY7C1041CV33 U2 CYPRESS CY7C1041DV33-10BVXI
BGA48_75_810

20 |1 PWR .65MM CONO045 | P9 DIGI-KEY CP1-023-ND

21 1 50MHZ OSC012 U35 DIGI-KEY 300-8264-2-ND

22 |2 MCP23017 U40,U41 DIGI-KEY MCP23017-E/ML-ND
QFN65P600X600-29N

23 |2 1UF 16V 10% 0805 C95,C96 DIGI-KEY 399-1284-2-ND

24 |2 GREEN LED_0603 LEDG6,LED7 DIGI-KEY 475-1409-2-ND

25 |3 0.1UF 16V 10% 0402 C37-C39 DIGI-KEY 587-1451-2-ND

26 1 15KV ESDAGV1SC D4 DIGI-KEY 497-6637-1-ND
SOT95P280-6N

27 1 30MHZ OSC012 U34 DIGI-KEY 300-8257-1-ND

28 |2 RED LED_0603 LEDS5,LEDS DIGI-KEY 475-2512-2-ND

29 | 4 YELLOW LED_0603 LEDI1-LED4 DIGI-KEY 475-2558-1-ND

30 1 10UF 6.3V 20% 0402 Cl4 DIGI-KEY 445-8920-1-ND

31 1 SN74CB3Q3245 U32 DIGI-KEY 296-19130-1-ND
TSSOP20

32 1 MIC2025-1 SOICS8 U44 DIGI-KEY 576-1057-ND

33 1 STD2805T4 Q1 DIGI-KEY 497-7465-1-ND
TO228P972X240-3N

34 | 8 IDC 2PIN_- SJ1-SJ8 DIGI-KEY S§9001-ND
JUMPER_SHORT
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Ref. | Qty. | Description Reference Manufacturer Part Number
Designator
35 1 150UF 10V 10% D CT2 DIGI-KEY 478-3321-2-ND
36 2 107.0 1/10W 1% 0805 R101,R107 DIGI-KEY 311-107CRTR-ND
37 1 1K 1/10W 5% 0603 R170 DIGI-KEY 311-1.0KGRTR-ND
38 2 4700PF 16V 10% 0603 | C44,C52 DIGI-KEY 311-1083-2-ND
39 10 2.21K 1/10W 1% 0603 | R78,R80,R84- | DIGI-KEY 311-2.21KHRTR-ND
R86,R108-R11
2
40 | 3 100 1/16W 5% 0402 R132,R137,R1 | DIGI-KEY 311-100JRTR-ND
39
41 7 330.0 1/16W 1% 0402 R115-R119,R1 | DIGI-KEY 541-330LCT-ND
31,R172
42 |2 165.0 1/10W 1% 0603 R102,R106 DIGI-KEY P165HTR-ND
43 1 220.0 1/10W 1% 0603 R77 DIGI-KEY P220HTR-ND
44 1 4.87K 1/10W 1% 0402 | R82 DIGI-KEY 541-4.87KHCT-ND
45 | 7 IDC 2X1 IDC2X1 JP1,JP4,P4-P7, | FCI 90726-402HLF
P10
46 | 2 IDC 3X1 IDC3X1 JP2,JP3 FCI 90726-403HLF
47 1 120.0 1/16W 1% 0603 R44 FEC 933-0496
48 1 IDT74FCT3244APY Us IDT IDT74FCT3244APYG
SSOP20
49 |1 TEST LOOP GP1 KEYSTONE 5016
LOOP_2838
50 1 VARISTOR V5.5MLA R1 LITTLEFUSE V5.5MLA0603
30A 0603
51 1 THERM 0.5A 0.4 1206 | R186 LITTLEFUSE 1206L050-C
52 1 USB_MINI-AB 5PIN P3 MOLEX 56579-0576
CONO052
53 |1 IDC 10X2 P1 MOUSER 571-5103308-5
TE_5103308-5
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ADSP-CM408F EZ-KIT Lite Bill Of Materials

Ref. | Qty. | Description Reference Manufacturer Part Number
Designator
54 | 7 10UF 6.3V 20% 0603 C10,C11,C13, | MULTICOMP MCCA000517
C126,C127,C1
33,C140
55 1 190 100MHZ 5A FER4 MURATA DILW5BSN191SQ2
FER002
56 1 DP83848 LQFP48 U43 NATIONAL DP83848CVV/NOPB
SEMI
57 | 2 DB9 9PIN CONO038 J2,]3 NORCOMP 191-009-213-L-571
58 1 GTL2002 TSSOP8 U10 NPX GTL2002DP118
59 |3 5A MBRS540T3G SMC | D6-D8 ON SEMI MBRS540T3G
60 1 15KV ESD7004 D5 ON SEMI ESD7004MUTAG
DFN50P250X100-10N
61 4 MOMENTARY SW2-SW5 PANASONIC EVQ-Q2K03W
SWT024
62 | 27 0 1/16W 5% 0402 R6,R8,R17,R4 | PANASONIC ERJ-2GEOR00X
5,R46,R49,R6
2,R63,R146,R
147,R151,R16
0,R163,R168,
R185,R190-R1
93,R196,R198,
R199,R202,R2
14,R229,R230,
R232
63 | 13 0 1/16W 5% 0402 R11,R12,R47, | PANASONIC ERJ-2GEOR00X
R48,R149,R15
9,R164,R166,
R184,R200,R2
01,R212,R213
64 | 4 1UF 6.3V 20% 0402 C12,C91,C93, | PANASONIC ECJ-0EBOJ105M
C94
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Ref. | Qty. | Description Reference Manufacturer Part Number
Designator
65 11 10UF 10V 10% 0805 C15,C16,C23, | PANASONIC ECJ-2FB1A106K
C27,C28,C41,
C42,C57,C58,
C77,C137
66 1 1.50K 1/16W 1% 0402 | R91 PANASONIC ERJ-2RKF1501X
67 | 2 27K 1/16W 5% 0402 R187,R188 PANASONIC ERJ-2GEJ273X
68 | 4 60.4 1/10W 1% 0603 R64,R65,R68, | PANASONIC ERJ-3EKF60R4V
R69
69 1 45.3K 1/10W 1% 0402 | R157 PANASONIC ERJ-2RKF4532X
70 1 24.9 1/10W 1% 0402 R13 PANASONIC ERJ-2RKF24R9X
71 1 10UF 10V 20% CT1 PANASONIC EEE-1AA100NR
ELEC_4MM
72 | 33 PI3A125 SC70_5 U4,U7,U13-U | PERICOM PI3A125CEX
31,U49-U60
73 | 2 PI4ULS3V08M U11,U12 PERICOM PI4ULS3VOSMZLE
QFN40P300X600X75-
33N
74 | 4 0.0 1/10W 1% 0603 R16,R176,R17 | PHYCOMP 2322702960011
7,R203
75 |1 RJ45 W/LEDS J1 PULSE ENG. JO011D21BNL
CONO065
76 1 200.0K 1/16W 1% R209 ROHM MCRO1MZPF2003
0402
77 1 IDC 3X2 P8 SAMTEC TSM-103-01-T-DV
IDC3X2_SMT
78 |1 IDC 5X2 J5 SAMTEC SSW-105-22-F-D-VS
IDC5x2_SMT_F
79 1 0.05 10X2 SAM- P2 SAMTEC SHF-110-01-L-D-TH
TEC_SHF-110-01-L-D-
TH
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ADSP-CM408F EZ-KIT Lite Bill Of Materials

Ref. | Qty. | Description Reference Manufacturer Part Number
Designator
80 2 0.5MM 180PIN SAM- J4.,]J6 SAMTEC QSH-090-01-F-D-A
TEC_QSH-090-F-D-A
81 1 0.5MM 120PIN SAM- J9 SAMTEC QSH-060-01-F-D-A
TEC_QSH-060-F-D-A
82 4 0.05 1/2W 1% 1206 R150,R154,R1 | SEI CSF 1/2 0.05 1%R
56,R165
83 10 49.9 1/16W 1% 0402 R89,R90,R92, STACKPOLE RMCF0402FT49R9
R93,R96,R98,
R103-R105,R1
55
84 3 600 100MHZ 500MA FERI1-FER3 STEWARD HZ1206B601R-10
1206
85 1 74IVC14A SOIC14 U3 TI 74IVC14AD
86 1 SN74LVC1G08 U48 TI SN74LVC1G0SDBVE
SOT23-5
87 |2 SN74LVC1G08 U45,U46 TI SN74LVC1G08SDBVE
SOT23-5
88 | 2 RJ11 4PIN CONO039 J7.]8 TYCO 5558872-1
89 1 3A RESETABLE F1 TYCO SMD300F-2
FUS004
90 3 0 1/8W 5% 0805 R15,R97,R178 | VISHAY CRCWO08050000Z0EA
91 20 10K 1/16W 5% 0402 R2-R5,R30-R3 | VISHAY CRCWO040210KOFKED
2,R36,R37,R3
9,R41,R42,R5
1,R75,R152,R
153,R182,R19
7,R219,R220
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Ref.

Qty.

Description

Reference
Designator

Manufacturer

Part Number

92

78

10K 1/16W 5% 0402

R10,R14,R18-
R20,R27-R29,
R33-R35,R38,
R40,R43,R52-
R58,R66,R67,
R70,R71,R79,
R81,R83,R87,
R88,R94,R95,
R100,R113,R1
14,R120-R130
,R133-R135,R
138,R140-R14
3,R148,R158,
R161,R171,R1
73-R175,R180
,R189,R194,R
195,R215-R21
8,R221-R228,
R231

VISHAY

CRCW040210KOFKED

93

33 1/16W 5% 0402

R7,R9,R59,R6
0,R76,R99,R1
36,R144,R145

VISHAY

CRCW040233R0JNEA

94

10K 1/10W 5% 0603

R204,R205

VISHAY

CRCW060310KO0JNEA

95

1M 1/10W 5% 0603

R179

VISHAY

CRCWO06031MO0OFNEA

96

10 1/10W 5% 0603

R61,R72-R74,
R162,R167

VISHAY

CRCW060310ROJNEA

97

30A GSOTO05 SOT23-3

D1

VISHAY

GSOT05-GS08

98

30A GSOT03 SOT23-3

D2,D3

VISHAY

GSOT03-GS08

929

22UF 16V 10% 1210

C100,C103,C1
05-C108
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